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Preface
For details, see the following topics:

• About this documentation

• Notation conventions

• Aurea global support

About this documentation
This guide is par t of the documentation set for Aurea CRM.

Notation conventions
This document uses the following notation conventions:

MeaningConvention

Fixed-width font indicates code, path names, file names, envi-
ronment variable names, parameter names, command names,
machine names, URLs.

Fixed-width

Bold Fixed-width  font is used to indicate user input or to
emphasize cer tain lines of code.

Bold Fixed-
width

Italic Fixed-width font indicates a placeholder for which you
must supply a value.

Italic Fixed-width

Bold sans serif typeface indicates the names of graphic user
interface elements such as dialog boxes, buttons, and fields.

Bold Sans serif

In text, italic serif typeface indicates the first use of an impor-
tant term. The term is defined in the glossary.

Italic serif

Underlined text in command lines and parameter descriptions
indicate that you only have to enter the underlined part of the
command or parameter name. For example, if you use
the-LOGFILE parameter in a command, you only need to enter
-LOGF.

Underlined

Brackets enclose optional arguments.[ ]

Braces enclose two or more items. You can specify only one
of the enclosed items. Vertical bars represent OR separators.
For example, you can specify a or b or c.

{ a | b | c }
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MeaningConvention

Three consecutive periods indicate that you can repeat the
immediately previous item. In code examples, they can be
horizontal or ver tical to indicate omissions.

...

An angle bracket between two menu items indicates that you
should choose an item from a menu. For example, the notation
File >  > Exit means: "Open the File menu and choose Exit."

Menu > Choice

Links to related information in other chapters or documents are
indicated using the >> symbol.

>>

Aurea global support
If you encounter a problem while using an Aurea product or require assistance with
downloading the software or upgrading a product release, please open a ticket on
Aurea Support Central. Preferably, search the ar ticles on the Aurea Knowledge
Base for solutions to your issues before opening a ticket.

Information about the support organization is available on Support Central. The
product documentation is available athttps://help.aurea.com/crm/#.

For information about purchasing an upgrade or professional services, contact your
account executive. If you do not know who your account executive is, or for other
queries, contact us through our website.
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1
CRM.mobile overview
Much like Aurea CRM, CRM.mobile enables you to search through CRM databases,
add records, edit records, delete records, synchronize data, and many others.

CRM.mobile allows users to access CRM data online from their mobile devices, e.g.
a smartphone. With CRM.mobile, you can access customer information, process
orders, and comprehensively manage your accounts remotely.

CRM.mobile gives you the ability to look up customer data and contact details. You
can use CRM.mobile to plan and document activities that allows you to engage with
your customers and potential leads.

Logging in and logging off
CRM.mobile securely protects your data and requires that you authenticate to gain
access.

To log in to CRM.mobile:

1. Tap the URL defined by your administrator to star t the CRM.mobile.

CRM.mobile’s login page is displayed.

2. Enter your username and password and select a language from the drop-down
list.

3. Tap Log In. The CRM.mobile star t page or the last open record is displayed
(depending on your configuration). For fur ther details, see Star t page on page 14
.
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To log off from CRM.mobile:

1. Tap  on the star t page. CRM.mobile’s login page is displayed.
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2
User interface
CRM.mobile's user interface uses various elements (tiles, quick actions etc.) to
navigate. The elements and functions available to you depend on your configuration,
the current record, and the current area.

Use the back button on your device to switch to the previous area.

Whenever you scroll, data and interface elements are loaded dynamically.
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CRM.mobile's user interface can be configured by your administrator to meet your

individual needs.

Fields and labels can be modified by your administrator.

Application menu
The application menu is displayed at the top of the current page. Here you will find
the most common options for your current page.

Depending on the current area, the application menu can contain the following op-
tions:
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DescriptionCRM.mobile main menu

Tap this button to open the star t page. For fur ther de-
tails, see Star t page on page 14.

 Star t Page

Tap this button to log out of CRM.mobile.
 Log out

Opens the search field where you can enter search
query. For fur ther details, see Searching on page 19.

 Search

Switches the current record to edit mode.
 Edit

Saves the current record. Save

Ends edit mode without saving any changes or closes
the search.

 Cancel/Close

Provides access to fur ther actions available for the
current record, e.g. add an activity for a company. For
fur ther details, see Adding and Editing Records on
page 21.

If you open the extended actions in the overview or
details view of a record, the actions apply to the cur-
rent record. Extended actions accessed from a list
(e.g. a results list) do not apply to a specific record.

 Extended actions

Adds a new record.
 New

Quick actions
Your administrator defines quick actions that allow you to quickly access the functions
you use most often (e.g. adding records, displaying company locations on the map).

By default, CRM.mobile includes the following quick actions:
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DescriptionCRM.mobile Quirk actions
button

Adds a new record (e.g. an activity).

Your administrator can define default values for new
records, e.g. the current date and time can be entered
by default in new activities.

 New

Displays the location of the current company or person
on a map (external application). The map application
is device-dependent. Map

Opens an external application, in this case for tele-
phone calls. Other external applications include Bing
Maps, your e-mail client, etc.

 External applica-
tion

Note: Your administrator can customize these quick actions icons.

Tiles
Your administrator defines tiles that provide you with an overview of the most
important information entered in the current record, such as a company’s ABC
classification, revenue, the number of activities, etc.

The Dashboard available on the star t page contains several tiles that allow you to
access specific information, such as today’s appointments or open opportunities.
For fur ther details, see Star t page on page 14.

DescriptionDefault configured tiles

Displays the ABC classification of a company.

Displays the number of child records. In this case,
the number of activities.
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DescriptionDefault configured tiles

Displays the results of a predefined search. In this
case, the number of open To-Dos.

Displays the type of activity and its priority.

If there are more tiles than can be displayed on the screen, scroll the page to load
additional tiles.

Fields
Fields are containers where you input data in CRM.mobile.Your administrator defines
which fields are required to have input.

Tap a field to enter data in it.

Note that some fields are combined in display mode, but are separate fields when
editing records. For example, the Street, Postal Code, City, and Country fields in
a company are displayed together in the Address field in the details view.

Note: Your administrator can define default values for specific fields.

Depending on the data stored in a field, an icon may be displayed next to the field:

DescriptionCommon icons of
fields

Opens the number in your external phone application
(device-dependent).Telephone

Opens the linked record. Linked recod

Opens the URL in a new window or tab.Website

Opens your e-mail client in a new window and transfers
the e-mail address to the To field.

 E-mail

Opens a location in your map application in a new window
or tab.

 Map

Note:  Some devices do not support opening new windows or tabs.

12AUREA CONFIDENTIAL

Chapter 2: User interface



Link fields
Link fields are fields that are linked to another record.

When adding and editing records, the  icon is displayed next to link fields.

To link a record with another record:

1. Tap on . The search field is displayed. For fur ther details, see Searching on
page 19.

2. Tap on the desired record to select it.

Note: You can change the record entered in a link field, but you cannot delete the
link.

Note: When you select a record, data from its parent record may be transferred to
the current record (if configured by your administrator). For example, a link to the
company a person works at could be entered when selecting a person.

Lists
Search results and child records like the activities or orders added for a company
are displayed in lists.

DescriptionList icons

If the list contains more entries than are
displayed, click here to display more
records.

Returns to the top of the list.

Tap on a list header or on  next to the header to open a new page containing only
this list.

Tap on a record to open it.
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You can scroll if the page contains more data than fits on your screen.

Figure 1: Example of a list

Start page
The star t page contains two tabs: Home and Dashboard.

By default, the Home tab displays your upcoming activities.

The records you opened most recently are listed under Recently Used. The most
recent record is listed at the top.

Various quick actions are available. For fur ther details, see Quick actions on page
10 . For example, click on New Activity to add a new activity containing the current
date and time.

Tap on  and  to display earlier or later activities.

Tap on an activity to open it.

Tap on  to display the calendar. For fur ther details, see Calendar on page 26.
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The Dashboard tab displays tiles that show the results of predefined searches.

Tap on a tile to view the corresponding records in list view.

Note: Your administrator can configure the tiles.
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Overview and details
If you tap on a record, the record is either opened in an overview or in the details
view.

The details of the record and child records are displayed. For example, when dis-
playing a company, the persons, activities and offers linked to the company are
displayed.

You can add and edit records. For fur ther details, see Adding and Editing Records
on page 21.

Depending on your settings, various quick actions (e.g. add a note) and tiles (e.g.
the number of activities) are displayed. For fur ther details, see User interface on
page 8.

Note: Your administrator can configure the overview and details view and define
which quick actions and tiles are displayed.

Tap on Overview or Details to switch between views of a record. You can also tap
on  and  next to the Overview and Details headers.

Tap on a tile linked to a search result (e.g. the number of activities) to display the
corresponding records. The results list is displayed. Tap on the tile containing infor-
mation (e.g. revenue) to switch to the details view.
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All details on the record and its child records are displayed, e.g. the company and
the associated persons and activities.

Figure 2: Overview of a record

Figure 3: Details of a record
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Searching
You can access the search from the star t page (global search and info area search).

Tap on  in the application menu to open the search. Tap on  to close the search.
If you search from the star t page, the search contains a global search area and
search areas for individual info areas. When returning to the search from the global
search results, the global search is also opened.

If no search term has been entered, the fields that the application searches in are
displayed in the search field. For example, the global search searches for persons
with matching first or last names. The search term will be found if it is entered in
any of the fields, i.e. when searching for "James", the search will return all persons
whose first or last name is "James".

Note: You can use the * wildcard. If you do not enter a wildcard, the search terms
are treated as though the * wildcard is present at both the star t and end of the search
term. This means that searching for ‘b’ will return all companies whose name includes
a ‘b’ anywhere in their name (e.g. "Bem", "ABC", "Aicob"). If you search specifically
for "b*", only those companies whose name begins with ‘b’ are gound (e.g. "Bem").
The search is not case-sensitive. Tap on  to clear the current search term.

Note: You can search for dates using the following formats: YYYYMMDD and
DD.MM.YYYY (e.g. 20131206 or 06.12.2013 for 6 December 2013).

Enter a search term and tap on  to star t the global search. All hits in the global
search areas (e.g. companies, persons, activities) are displayed.
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Tap on a list heading to display the list of results in just that info area.

Click on one of the info areas under Search by to search in a specific info area.

Tap on , e.g. next to Companies to search in a specific info area. The search
only searches in the selected info area and displays the results, for example, the
matching companies. When searching in a specific info area, the system searches
for the search term in the search fields defined for the info area (e.g. Company,
Synonym, Country, City and Postal Code for companies).

Tap on  in a list to search in the current info area (e.g. search for companies).
Apply or remove filters by clicking on them or to return to the global search. The
search term is only searched for in the current info area. Filters are applied to the
search as additional criteria (using a logical AND) alongside your search term.

Note: Your administrator defines filters for you.

20AUREA CONFIDENTIAL

Chapter 2: User interface



3
Adding and Editing Records
Records can be modified in CRM.mobile. You can add and edit cer tain records
determined depending on the permission set by your administrator.

Note: Your administrator determines which records you can edit and add.

Note:  By default, you cannot delete records or add catalog values in CRM.mobile.

Adding Records
CRM.mobile allows you to add records like to-do lists and and activities.

You can add records in CRM.mobile using quick action and extended actions ( ).
If only a single extended action is available,  (New) is displayed instead. For fur ther
details, see User interface on page 8.

To add a new record:

1. Switch to the area where (e.g. results list) you want to add the record or open a
record to add a child record. For fur ther details, see Searching on page 19.

2. Tap on Extended Actions in the application menu.

The actions available for the current record or area are displayed:

Note: Your administrator can define default values for specific fields. When
adding a new record, the default values are automatically entered in the
corresponding fields.

3. Select an option to add a new activity.

4. Enter data on the fields.
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Mandatory fields are highlighted in red.

5. Tap on  or tap on  to save in the application menu.

The new record is displayed.

Note:  If you add a To-Do and link it to a ticket, you cannot edit the date and time
of the To-Do once the record has been saved.

Note: When adding an activity, enter the star t date and time, duration and time
units (e.g. minutes or days). If the Create To-Do field is enabled, To-Dos are added
for all par ticipants (for activities scheduled in the future).

Editing Records
Updating a record in CRM.mobile is possible depending on the permission set by
the administrator.

To edit a record:

1. Switch to the desired record. For fur ther details, see Searching on page 19.

2. Tap on  edit to switch to edit mode.

3. Edit the record.

4. Tap on  or tap on  to save in the application menu.

The record is displayed.

Selecting reps
You can enter reps in specific fields. For example, when adding an activity, you are
automatically entered in the Rep ID field. You can assign activities to your colleagues
by entering them instead.

A rep is a representative of a company who can login to CRM with cer tain rights for
performing administrative, technical, business tasks, etc.

To select a rep:

1. Tap on  next to the Rep ID field. For fur ther details, see Link fields on page 13.

A list of all reps is displayed. Search for the desired rep. For fur ther details, see
Searching on page 19.
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2. Tap on a rep to select the rep.

The search area is closed and the rep is entered in the Rep ID field.

Adding internal participants
You can add internal par ticipants to activities.

To add an internal par ticipant:

1. Switch to the desired activity and tap on  or add a new activity. For fur ther
details, see Adding Records on page 21.

2. Tap on  under Internal Participants.

A list of all reps is displayed. Search for the desired rep. For fur ther details, see
Searching on page 19.

Note: The list also includes resources and groups. These are indicated with R
and G respectively.

3. Tap on a rep to select add the rep as a par ticipant.

The search area is closed and The rep is added to the list of Internal Participants.

4. Tap on  next to the participant.

The available par ticipation types are listed (  Required  Optional and  Informa-
tional).

5. Tap on the desired participation type.

The activity record is displayed in edit mode again.

Note: You can subsequently change the participation type.

6. Tap on  next to a par ticipant to remove the participant.
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Note: The rep entered in the Rep ID field (by default, the rep who added the
activity) is automatically added as a par ticipant with the participation type set to

 Required. This rep cannot be removed as a par ticipant. Change the rep entered
in the Rep ID field to change the participant. For fur ther details, see Selecting
reps on page 22.

Note: You can only change your own participation status. To do so, tap on the

current status (  Open,  Accepted,  Denied or  Not relevant) and choose
the desired status.

Adding external participants
You can add external par ticipants to activities.

To add an external participant:

1. Switch to the desired activity and tap on  or add a new activity. For fur ther
details, Adding Records.

2. Tap on  or  under External Participants to add a company
or persons as a par ticipant.

A list of all companies or the persons in companies is displayed. Enter a search
term and star t the search to restrict the list of records. For fur ther details, see
Searching.

3. Tap on a company or person to add them as a par ticipant.

The search area is closed and the company or person is added to the list of Ex-
ternal Participants.

You can remove participants and change their par ticipation type and status as with
internal par ticipants.

Note: The company or person the activity was added for is automatically entered
as an external par ticipant with the participation status Required. You cannot
delete this company from the list of par ticipants nor change the participation type.
You can however change the participation status.
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Entering dates and times
Dates and times are important entries when adding or editing records. They can
either be mandatory or optional data depending on the type of record you are adding
or editing.

To enter a date and a time:

1. Tap on the field where date/time is required (e.g. Starts on, Starts at).

2. Select your chosen date/time.

The method of entering dates and times depends on your device.
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Calendar
The calendar displays your activities and free time based on your personal work
hours. You can add new activities to the calendar.

To open the calendar, tap on  on the Home tab on your star t page.

The calendar is opened in the Month tab. The Agenda tab contains a list of your
upcoming activities. By default, activities that star t in the past are not displayed.

Note: Your administrator can determine that past activities are also displayed on
the Agenda tab. Your administrator can also determine the date that is displayed
when opening the calendar.

Month
The month tab displays the month of the current date.

Month Tab

• By default, the current date is selected when you open the calendar.

• The currently selected date is highlighted in orange ( ).

• The current date is always indicated by an orange border ( ) when not
selected.

• The selected day’s activities and free time periods are displayed below the
calendar.

• Tap on  or  to navigate to the previous or next month. The activities and free
time periods beneath the calendar are updated.

• If activities are scheduled for a date, the number is displayed in bold.

• Days in the previous or next month are light gray. Tap on a day to select it and
switch the view to that month.

• Tap on a selected day or a free time slot beneath the calendar to add a new
activity. For fur ther details, see Adding Records on page 21.
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• Tap on an activity beneath the calendar to open display an overview of the activity.
For fur ther details, see Overview and details on page 16.

• Activities lasting for more than a single day are always displayed at the top of
the list, irrespective of when they star t.
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Note:  All-day appointments are ignored when calculating free time periods.

Figure 4: Month tab

• Tap on  next to a date to add a new activity on that day.
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Note: When adding a new record, cer tain values are entered automatically (e.g.
Starts on, Starts at). You can edit these values. No message is displayed if activities
conflict with one another. Your administrator can determine which activities are
displayed in the list (e.g. only visits).

Agenda
The agenda displays activities that are scheduled.

Figure 5: Agenda tab

• Tap on an activity to open the overview. For fur ther details, see Overview and
details on page 16.

• Click on an overview of an agenda to see the detailed view.

• To-do list is also displayed in the Agenda tab.
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